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Abstract. The cell mechanical assay has emerged as a powerful approach to studying cellular behav-
ior and protein dynamics. This work presents the novel protocol that combines cell nanomechanical
assay with rapid protein expression profiling, enabling comprehensive insight into cellular responses.
The new protocol leverages advanced techniques in atomic force microscopy (AFM) to measure the me-
chanical properties of individual cells, while simultaneously utilizing a laser scanning microscopy for the
high-throughput quantification of protein expression levels. This dual-assay method allows researchers
to elucidate the relationship between cellular mechanical properties and protein dynamics, uncovering
critical insights into cellular physiology and pathophysiology. The effectiveness of the protocol was vali-
dated through experiments with cancer cells, showcasing its potential in colocalization of wnt3a ligand
molecule and actin cytoskeleton with Young’s modulus patterns of the cell. Our findings indicate that
this integrated approach not only enhances the accuracy of cellular assessments but also accelerates the
understanding of cellular mechanisms at the nanoscale. This protocol holds promise for applications in
drug development, diagnostics, and personalized medicine, offering a new lens through which we can
explore the intricate interplay between cellular mechanics and protein expression.
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Introduction

Atomic Force Microscopy (AFM) is a tool often used for studying biological structures and
processes at cellular and molecular scales. It offers the ability to image live cells at a resolution
much higher than light microscopy allows [1]. AFM is particularly significant in the analy-
sis of cell and biomechanics, where it quantifies mechanical parameters related to cytoskeleton
organization [2].

However, quantifying cell mechanics presents its own challenges. The main one is that the
cell senses external mechanical stimuli and changes its metabolic profile, which in turn changes
its mechanical properties [3]. This is a prerequisite for understanding the role of mechanosens-
ing and the cellular response expressed as changes in cell stiffness and tension. At the same
time, measuring the relationship between molecular kinetics and cell mechanics opens up new
possibilities for understanding the adaptive mechanobiological mechanisms of cells that have yet
to be fully understood [4]. Combining Laser Scanning Microscopy (LSM) with Atomic Force
Microscopy (AFM) can significantly enrich data acquisition for cell and biomaterial research.

AFM is a technique that provides high-resolution images, which allows users to view surfaces
under any aqueous conditions. It is used to study the structural and mechanical properties of a
wide range of biological matters like biomolecules, cells, and tissues. However, AFM studies are
typically limited to imaging the surface of the cell membrane [5].

On the other hand, LSM is an optical imaging technique that offers a variety of supplemental
datasets. While AFM provides valuable information from the topography mapping of a sample
surface, LSM allows the acquisition of molecular marker distributions [6]. Hence, when combined,
they can provide comprehensive information on surface structure, mechanical topography and
specific molecular distribution.

The combination also permits structural mapping of properties and enables manipulation
with molecular precision [6]. This combined mapping of immunohistochemical and topographical
properties aids in delivering more comprehensive and detailed data [7].

Previously we proved that mechanical properties of glioma cells depend on the expression of
CD44 receptors on the cell surface [8].

We verified this protocol on WNT3a and actin colocalization with nanomechanical properties
obtained by AFM.

Wnt ligands are secreted proteins which activate the wnt pathway by interaction with Frizzled
protein (Fz) and cytoplasmic low-density lipoproteins LRP 5/6 [9]. Canonical wnt3a pathway
involved in all cell and tissue processes including cell division, differentiation, malignization and
epithelial-mesenchymal transition [10–12]. Several studies are devoted to anticancer therapy
based on targeting on wnt3a protein or its receptor. The main targets are Disheveled (Dvl)
protein [13], PORCN, or miRNA assays [14].

It was shown that wnt3a has a significant impact on glioblastoma cell migration and prolifer-
ation both in vitro and in vitro. Glioblastoma cells are synthesizing Wnt3a which increases local
microglial ARG-1 and STI1 expression, followed by an upregulation of IL-10 mRNA levels, and
a decrease in IL1β gene expression. The presence of Wnt3a in microglia-glioblastoma co-cultures
increases the formation of cell membrane actin cytoskeleton accompanied by changes in migration
capability. In vivo, tumors formed from Wnt3a-stimulated glioblastoma cells presented greater
microglial infiltration and more aggressive characteristics such as growth rate than untreated
tumors [15].

In this study, we propose a fast and effective assay for conducting live cell imaging using the
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combined strengths of Atomic Force Microscopy (AFM) and Laser Scanning Microscopy (LSM).

1. Materials and methods

1.1. Cell culture assay

Glioma early-passage cell cultures BT32, BT39, BT40, BT52 established from tumor samples
described previously were used in this work [8]. The established cell cultures were cultivated until
the 80% confluency; then, the cells were removed from the flask surfaces by using 0.25% trypsin
solution (Thermo Fisher, Waltham, MA, USA) and reseeded on sterile coverslips laying in cell
culture dishes. High-glucose DMEM with 1mM sodium pyruvate and 300 mg/L L-glutamine
(Thermo Fisher, Waltham, MA, USA), 10% fetal bovine serum (FBS) (Thermo Fisher, Waltham,
MA, USA), penicillin (50 U/ml) and streptomycin (50 ug/ml) (Thermo Fisher, Waltham, MA,
USA) was used.

1.2. Atomic force microscopy

We used a Bruker BioScope Resolve microscope (Bruker, USA) for atomic force microscopy
(AFM). The probes selected for the experiments were PFQNM-LC-A-Cal and SNL-C (Bruker,
USA). Before each experiment, the probe was calibrated. The cantilever spring constant values
provided by the manufacturer were cross-checked by performing a thermal noise calibration [16]
and the calibration was performed on a solid surface. This calibration was necessary to determine
the deflection sensitivity by obtaining multiple force curves on a rigid sample, which formed the
basis for subsequent analysis. In addition, we determined the tip radius by reconstructing it, an
operation that involved imaging a rough titanium sample (Bruker, USA). Before atomic force
microscopy, the cells were fixed with 4% PFA (Sigma, USA) prepared in 1x PBS.

During Atomic Force Microscopy (AFM) scanning, measures were taken to prevent cellular
damage and ensure the generation of quality force curves. These steps included limiting the tip
velocity to 66 µm/s, setting the peak force tapping frequency at 0.5 kHz, defining the image scan
size at 100 µm, and fixing the number of samples per line and the number of lines at 256 each. The
initial force curves analysis was carried out utilizing the Derjagin, Muller, Toropov model (DMT-
model [17]). This model was crucial in analyzing sample deformation by an amount smaller than
the probe’s radius. The nanomechanical analysis was carried out using the NanoScope analysis
software (Bruker, USA), which was provided with the atomic force microscope. The subsequent
data analysis for group classifications (parametric and non-parametric statistics) was carried out
using GraphPad Prism 8 software (GraphPad Software, USA).

1.3. Immunocytochemistry (ICC)

Cells were fixed in 4% paraformaldehyde prepared on PBS for 15 min and washed 3 times for
5 min in 0.05% Tween-20 (Helicon, RF) prepared on PBS (PBS-T). The next step was membrane
permeabilization by Triton X-100 (Helicon, RF) 0.5% solution prepared on PBS for 5 min at
room temperature. Cells were blocked by incubation for 2 h with 3% Bovine Serum Albumin
(Sigma–Aldrich, USA) prepared on PBS. Cell labeling was performed by using primary antibodies
wnt3a (ServiceBio, China) and Rhodamine–Phalloidin staining (Thermo–Fisher, USA) in supply-
recommended titer in PBS for 2 h at room temperature. Alexa Fluor 488 goat anti-rabbit IgG
(H+L) (a11034, Thermo–Fisher, USA) secondary antibodies were used. The labeling procedure
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was performed for 1 h at room temperature. To stain the nucleus, we added DAPI (Sigma–
Aldrich, USA) for 10 min with concentration of 300 nM in the final washing step.

1.4. Laser scanning microscopy

Laser Scanning Microscopy (LSM) was conducted using an Olympus FV1200 microscope
(Olympus, Japan). We chose a magnification setting of x60 (Olympus UPlanSAPO 60X ) and
set the scanning resolution to 1600. The coverglasses with fixed and stained cells were transferred
on a clean slide and embedded in Mowiol 4-88 solution. In order to yield comparative data on
protein expression, we ensured that all images were procured under consistent image acquisition
parameters. Additionally, these images were systematically taken in a manner such that they
encompassed the fields acquired through Atomic Force Microscopy (AFM).

1.5. Image overlaying and colocalization assay

To effectively overlay the atomic force microscopy (AFM) and laser scanning microscopy
(LSM) images, ImageJ software was used. To ensure effective overlay, the color scheme of each
AFM image was adjusted to effectively separate invalid zero values as well as the plastic substrate.
After that, the AFM image was imported into ImageJ software and manually overlaid onto the
LSM image. The Coloc2 plugin was used to calculate the colocalization of AFM and LSM data.
The median fluorescence was then colocalized to Young’s modulus.

In this study, we employed Pearson’s correlation coefficient (PCC) and Manders’ colocal-
ization coefficient (MCC) to quantitatively assess colocalization in imaging data. The PCC is
calculated using the intensities of the red (Ri) and green (Gi) channels for each pixel (i), along
with the mean intensities (R and G) of the respective channels across the entire image. The
formula for PCC is presented below:

PCC =

∑
i(Ri −R)× (Gi −G)√∑

i(Ri −R)2 ×
∑

i(Gi −G)2
(1)

and resulting values can range from +1, indicating a perfect linear relationship between the
fluorescence intensities of the two channels, to –1, signifying a perfect inverse relationship Man-
ders’ colocalization coefficient (MCC) is a valuable metric for determining the proportion of one
protein that colocalizes with another. When analyzing two probes, referred to as R and G, two
distinct MCC values are generated: M1, which represents the fraction of R found in compart-
ments that contain G, and M2, which indicates the fraction of G in compartments that contain
R. The calculations for these coefficients are as follows:

M1 is calculated as:

(M1 =

∑
i Ri,colocal∑

i Ri
), (2)

where (Ri,colocal = Ri) if (Gi > 0) and (Ri,colocal = 0) if (Gi = 0).
M2 is calculated as:

(M2 =

∑
i Gi,colocal∑

i Gi
), (3)

where (Gi,colocal = Gi) if (Ri > 0) and (Gi,colocal = 0) if (Ri = 0).
Costes et al. [18] introduced a novel method for automatically determining the threshold value

used to identify background levels. This method involves analyzing the range of pixel values that
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yield a positive Pearson correlation coefficient (PCC). Initially, PCC is calculated for all pixels
in the image, and then it is recalculated for pixels corresponding to the next lower red and green
intensity values along the regression line. This iterative process continues until the pixel values
reach a point where the PCC falls to zero or below. The red and green intensity values at this
juncture are established as the threshold values for identifying background levels in each channel.
Only pixels with red and green intensity values exceeding their respective thresholds are classified
as having colocalized probes. The MCC is then computed as the fraction of total fluorescence
within the region of interest that is attributed to these "colocal" pixels [19].

2. Results

2.1. WNT3a intensity does not depend on cell nanomechanical
properties

Glioma early-passage cells were seeded on coverslips fixed and atomic force microscopy was
done. Following cell labeling and laser scanning microscopy colocalization analysis was performed
to investigate the relationship between nanomechanical properties of cells and local expression
of WNT3a protein and fibrillar actin in 4 cell cultures. The modified tM1, tM2 coefficients
(threshold Manders’ coefficients, MCC) and Pearson coefficient (PCC) were calculated, for which
the ImageJ software threshold values were used.

The distribution of actin in all studied cell cultures showed significant colocalization with
Young’s modulus values. For the BT32 cell culture, Manders’ colocalization coefficients were
0.817 (tM1) and 0.6 (tM2), indicating the extent of actin fluorescence detected over Young’s
modulus (tM1) and vice versa (tM2) (Fig. 1A). However, the Pearson correlation coefficient was
relatively low at 0.01, reflected by a wide scatter in the scatterplot. This suggests a potential
nonlinear relationship between the actin fraction and Young’s modulus or a low dependency
between these values (Fig. 1B).

Similar patterns were observed in other cell cultures, characterized by high Manders’ colocal-
ization coefficients (MCC) and low Pearson correlation coefficients (PCC). For BT39, the tM1,
tM2, and PCC values were 0.99, 0.98, and 0.09, respectively; for BT52, the values were 0.98, 0.94,
and 0.15; and for BT40, the values were 0.9, 0.68, and 0.04. Colocalization images displayed a
predominance of colocalized pixels (gray) over non-colocalized pixels (red for actin and green for
nanomechanics) (Fig. 1A). Scatterplots also suggested a complex relationship between Young’s
modulus and the actin fraction (Fig. 1B).

The distribution of Wnt3a in the studied cell cultures showed considerable heterogeneity
in colocalization with Young’s modulus values. In the BT39 cell culture, tM1 and tM2 were
relatively high at 0.99 and 0.98, respectively, while the Pearson correlation coefficient (PCC)
was –0.06. About 97% of the non-zero pixels for Wnt3a overlapped with Young’s modulus values
(Fig. 1C), though the scatterplot of Wnt3a and Young’s modulus intensities was widely dispersed
(Fig. 1D).

For BT40 and BT52 cell cultures, tM1 and tM2 values were moderate: 0.81 and 0.49 for
BT40, and 0.82 and 0.56 for BT52. Similar to BT39, the PCC values for BT40 and BT52
were close to zero, at –0.05 and –0.06, respectively. The images displayed a significant number
of non-colocalized Young’s modulus regions (Fig. 2C), and the scatterplots for these cultures
also showed a broad distribution (Fig. 1D). In contrast, the BT32 cell culture exhibited weak
colocalization between Wnt3a and Young’s modulus, with tM1 at 0.07 and tM2 at 0.2.
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Fig. 1. Actin and WNT3a colocalization with Young’s modulus: A. Merged images of actin,
Young’s modulus and colocalized data; B. Merged images of wnt3a, Young’s modulus and colo-
calized data

The images revealed a large number of non-colocalized patterns for both Young’s modulus and
Wnt3a, with very few colocalized areas (Fig. 2C), further supported by the scatterplot indicating
low colocalization (Fig. 2D).

Probes with both large and small tip radii were tested.
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The sharp probe (SNL) demonstrated high indentation values in the cell, which led to
"sticking", especially on rough or soft cell areas like the nucleus (Fig. 2A). These probes are
suitable for precise analysis of rigid samples like plastic substrate or lyophilized protein sample
(Fig. 2B). Probes with a larger tip radius are generally more suitable for AFM imaging of cells
(Fig. 2C).

Fig. 2. The influence of the probe shape on AFM visualization: A. Cell visualized by the sharp
SNL probe; B. Cell culture plastic visualized by the sharp SNL probe; C. Cell visualized by the
probe with high tip radius; D. LSM image in grayscale with inappropriate microscope settings;
E. LSM image in grayscale with appropriate microscope settings

Properly adjusting the LSM detector sensitivity and laser power is crucial for colocalization
analysis (Fig. 2C,D). Incorrect settings can affect the PCC values due to invalid pixel intensities
caused by overexposure or underexposure. Similarly, it’s important to adjust the AFM pseudo-
color scheme to ensure sufficient contrast for visualizing the cells (Fig. 3A). This includes setting
a range for invalid/zero values and substrate data (Fig. 3B), allowing the final AFM image to
clearly distinguish invalid data from the substrate (Fig. 3C).

During AFM and LSM scanning, clusters of invalid data may be acquired. Removing this data
is essential for accurate colocalization analysis. Instead of manually drawing regions of interest
(ROI), it’s preferable to use a mask generated from the AFM image (Fig. 4A). Transferring this
ROI to the LSM image ensures that any LSM data not covered by AFM is removed (Fig. 4B).
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Fig. 3. AFM image color scheme adjustment: A. Data scaling to focus on the cell; B. Editing
the color table to visualize the data referred to cell surface; C. The resulting AFM image

Fig. 4. LSM image editing to exclude the data not represented on AFM slide: A. The mask
done on AFM image. White color refers to the surfaces without valid AFM data; B. Initial LSM
image that have the same resolution, and the data not represented on AFM image (Green arrow,
yellow lines) and cleaned LSM image

2.2. Procedure for AFM-LSM colocalization

1. Passage the cells on sterile coverglasses, or confocal cell culture dishes (Nunc 150680 or
similar) for 1–2 days to allow the cells to recover their protein expression and synthesize
surface markers, damaged by previous disaggregation.

(Timing 1–3 d).

2. Propagate the atomic force microscopy:

a. Remove the media and fix the cells with a 4% buffered PFA solution for 15 minutes.

b. Carefully rinse the cells 3 times for 5 minutes with the warm PBS. Avoid scratching the

– 137 –



Mikhail E. Shmelev . . . A Novel Protocol for Cell Nanomechanical Assay . . .

cell substrate.

c. Choose an appropriate probe — the sharp and stiff probes are more suitable for small
and rigid objects, and not always suitable for the cells (Fig. 2 A,B). The probes with
large tip radius are better for the cell visualization, especially when the scan size exceeds
10 um (Fig. 2 C). However, the microscopy’s effective resolution usually does not allow
to visualize small objects (less than 200 nm), so very high resolution of an AFM image
may be useless in order to AFM-LSM colocalization.

d. The critical step is probe calibration. To promote a reliable and valid scanning is
required to estimate the deflection sensitivity, spring constant and tip radius/tip half
angle (this depends on the model used to calculate the sample Young’s modulus).

e. The AFM scanning parameters should be chosen in order to promote high resolution
which must not be lower than LSM image and not damage the cell. The optimal
resolution for the 100 um AFM image is 256–512 samples/line.

f. It is strongly recommended to perform a Bright field or Phase contrast image of each
AFM-examined cell for the effective AFM-LSM overlaying.
(Timing 1–2 d).

3. Perform antibody labeling:

a. For an effective AFM-LSM colocalization the investigated marker must be localized on
the cell surface, or very close to it, so membrane permeabilization may not be useful.
Moreover, harsh detergents such as Triton X-100 or NP-40 may solubilize cell membrane,
membrane-associated antigens and change its mechanical properties. So, use it carefully.
The optimal detergent and the permeabilization time should be optimized for each cell
line and the investigated protein. One of the most used reagent is Triton X-100 in the
concentration of 0.05–0.1% in PBS and the incubation time is 3–5 minutes.

b. Carefully rinse the cells 3 times for 5 minutes with the warm PBS. Avoid scratching the
cell substrate.

c. Block the cells using the bovine serum albumin, 3% on PBS for 2 hours on room tem-
perature or overnight on +4. Use the moisture chamber to avoid drying the sample.

d. During the previous step prepare the antibody solution in desired dilution on PBS.
Avoid the freeze-thaw cycles of the antibody stock.

e. Carefully rinse the cells 3 times for 5 minutes with the warm PBS. Avoid scratching the
cell substrate.

f. Cover the sample with the antibody solution. Incubate 2 hours at room temperature or
overnight on +4. Use the moisture chamber to avoid drying the sample.

g. During the previous step prepare the fluorophore-conjugated antibody solution in desired
dilution on PBS. Avoid the freeze-thaw cycles of the antibody stock and light exposure
to prevent photobleaching.

h. Carefully rinse the cells 3 times for 5 minutes with the warm PBS. Avoid scratching the
cell substrate.

i. Cover the sample with the antibody solution. Incubate 2 hours at room temperature or
overnight on +4 away from light.

– 138 –



Mikhail E. Shmelev . . . A Novel Protocol for Cell Nanomechanical Assay . . .

j. Carefully rinse the cells 3 times for 5 minutes with the warm PBS. Avoid scratching the
cell substrate.

k. Stain the nucleus with DAPI or PI and actin cytoskeleton with Phalloidin-fluorophore
conjugate if necessary, away from light.

l. If you used coverslips as a cell substrate, transfer them on clean slides, with an addition
of 15–20 ul of mounting medium. Place coverslip over the slide using tweezers. If using
an aqueous mounting medium, seal with limonene or nail polish.
(Timing 1 d).

4. Examine the samples using Laser scanning microscopy. For cell visualization combined
with AFM, objectives with a magnification of more than 60x are most preferred.

a. When doing microscopy, adjust the laser power and detector sensitivity in order to
avoid overexposed and underexposed pixels (Fig. 2D,E). Use the same image acquisition
setting to acquire comparable intensity data.

b. If possible use the same picture resolution (pixels/um) as the AFM resolution.
(Timing 1d).

5. Set up the AFM Young’s Modulus Image Color Scheme.

a. Adjust the image data scale to show the cell surface in detail. The data scale should
range from zero to the hardest part of the cell surface (Figure 3A).

b. Set up the color scheme. The color plot should include 3 regions: zero and invalid data
points; the bulk of the cell surface; and the substrate region. The bulk of the color plot
should be in a single color channel — red, green, or blue — and should not overlap with
zero or substrate data points, which should be in a different single color (Fig. 3B,C).

c. Export the resulting image as a high-resolution, uncompressed .tif file.
(Timing 20–30 min).

6. Overlay the AFM and LSM image using ImageJ or another raster graphics editor.

a. Modify LSM image in order to effective overlay the AFM image — flip picture if neces-
sary, rotate and resize it.

b. Crop the LSM to AFM picture size and match the cell structures on both images.

c. Import the AFM image to ImageJ, separate the channels by Image → Color → Make
Composite command, then split the channels by Image → Color → Split Channels
command. Save the obtained images in .tif.

d. Import the prepared LSM image to ImageJ and do the same manipulations as described
in the previous step. Save the obtained images in .tif.
(Timing 2–4 h).

7. Perform the image colocalization analysis using ImageJ.

a. Create a negative image mask based on the AFM image obtained on 8c step by using
Image → Adjust → Threshold command. Use the values between 0 and 1 (Fig. 4A).
This step is needed to remove all the data on the LSM image which is not covered by
AFM.
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b. Create the composite Region of Interest by Analyze → Analyze particles command.
The values of the fields "Size" and "Circularity" must be "0-Infinity" and "0.00-1.00",
respectively, parameters "Add to manager", "Include holes", "Overlay", "Composite
ROIs" must be tagged on. Other parameters are out of interest in this analysis. As a
result a bulk of regions of interest will be obtained. (Fig. 4B).

c. Transfer the ROIs obtained on the previous step to each stack of LSM images obtained
on the 8d step and delete the data in these ROIs.

d. Use Coloc2 or ColocalisationThreshold plugin to perform pixel-wise colocalization anal-
ysis.

(Timing 1 h).

3. Discussion

It was shown that β-actin and other cytoskeleton components have a significant impact on
cell rheology. However, not only cytoskeleton itself modulates cell mechanics, it always bounded
to various proteins , such as myosin and tropomyosin, which could modulate cell mechanics via
contractile forces [20], or could change actin conformation [21]. The weak Pearson correlation
between cell surface nanomechanics and actin cytoskeleton localisation may be explained by lo-
calisation of actin fibers deep inside the cell or altered contractility of actin-myosin compounds
and therefore, non-linear dependency between Young’s modulus and actin expression [22]. How-
ever, high MCC values indicate that actin cytoskeleton provides a significant impact on cell
mechanics.

Wnt3a is a target gene of regulatory RNA such as miR-491 and miR-491 that mediates
epithelial-mesenchymal transition (EMT). Additionally, miR-491 regulated the proliferation
through the Wnt/β-Catenin pathway by targeting Wnt3a [11]. Wnt3a downregulation leads
to Wnt-signaling alteration and increased sensitivity to temozolomide in vitro [23]. It was shown
that Wnt3a receptor — LRP6 protein is associated with lipid rafts [24] and signal transduction
modulated by Wnt3a is hypothesized to modulate local membrane hardness and could be an
effective nanomechanical marker for EMT. However, the results, which show varying levels of
colocalization across different cell cultures, cast doubt on this thesis.

The method used for this investigation could be used for the various implementations con-
nected to the AFM and LSM studied and used for the direct proof of physical relations between
studying protein and membrane stiff structures such as lipid rafts or cytoskeleton local complexes.

AFM is rarely used in combination with LSM. Several papers including high-resolution AFM-
LSM scanning [25], actin cytoskeleton scanning [26], cell receptor visualization [27] and SEM-LSM
scanning [28]. However, these studies did not perform a quantitative assessment of data from one
area obtained by different methods. Moreover, hardware optical laser scanning AFM systems
are not widely used and are expensive. Our method will make it possible to effectively use data
obtained in various ways for multivariate analysis of biological systems.

Conclusion

Comparing data from different microscopy techniques can be challenging. Our ImageJ-based
method offers a fast, reliable, and free way to analyze cell surfaces captured by various imaging
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methods, both optical and non-optical. This approach enhances the versatility of the data and
enables a quantitative evaluation of specific features of interest.

This research was funded by the Russian Science Foundation (project no. 20-15-00378п).
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Новый протокол для анализа клеточной наномеханики
в сочетании с быстрым белковым профилированием
с помощью колокализации паттернов АСМ-ЛСМ
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Аннотация. Атомно-силовая микроскопия стала одним из ключевых методов изучения клеток
и белков. В этой работе представлен новый протокол, который сочетает в себе наномеханическое
исследование клеток с быстрым профилированием экспрессии белков, что позволяет получить но-
вый источник данных для фундаментальных и прикладных исследований в области клеточной
биологии. Новый протокол основан на методах атомно-силовой микроскопии (АСМ) для измере-
ния механических свойств отдельных клеток и лазерной сканирующей микроскопии (ЛСМ) для
высокопроизводительного количественного анализа уровня экспрессии белков. Такой подход поз-
воляет оценить взаимосвязь между механическими свойствами клеток и динамикой белков, рас-
крывая важные аспекты физиологии и патофизиологии клеток. Эффективность протокола была
подтверждена экспериментами с раковыми клетками, демонстрируя его потенциал в колокализации
молекулы лиганда wnt3a и актина цитоскелета с картинами модуля Юнга клетки. Разработанный
подход найдет свое применение в разработке лекарств, диагностике злокачественных опухолей и
персонализированной медицине, предлагая новый взгляд на сложное взаимодействие между меха-
никой клеток и локальной экспрессией белков.

Ключевые слова: атомно-силовая микроскопия, лазерная сканирующая микроскопия, колокали-
зация, глиомы, wnt-сигналинг.
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